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Computer Learning Center Users’ Group 

Selected Windows Settings 
Introduction. The purpose of this presentation is to introduce appearance options for your 
Windows desktop, not to dictate which appearance choice is correct. Experiment with your own 
computer to discover which combination of settings works the best for you. 

Display Properties 

Right-click on the open desktop (or select the Display icon on the Control Panel) 

Select Properties on the resulting menu 

! The Themes tab 

" Select a theme from the list, or save your own 
Click Apply 

! The Desktop tab 

" Select a background picture for the desktop. 
Click Browse. 

Navigate to and select a “jpg” or “bmp” file 

Click Open 

When the Display Properties menu returns, click Apply 

On the Position menu, experiment with each of the options by selecting it and then 
clicking Apply. 

 The Color option only applies if you are not using a background picture 

" Click Customize Desktop 
Desktop Icons determines whether icons for each function automatically appear on 
the desktop.  

Recommendation: Select My Computer, My Documents, and Internet Explorer 

" Desktop Cleanup 
Recommendation: Uncheck the Run Desktop Cleanup Wizard every 60 days. 

Click OK 

Click Apply if it is available 

! The Screen Saver tab 

" Select a Screen Saver. For example: 
Select Marquee 

Select 10 minutes in the Wait box 

Leave the On resume, password protect box unchecked 

Click the Settings button 

Under Position, select Random 
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Under Speed, position the slider in the middle 

In the Text box, type: Not all who wander are lost. 

Click the Format Text button 

Under Size, select 72 

Under Effects select Fuchsia as the color 

Click OK, returning you to the Marquee Setup window 

Click OK, returning you to the Display Properties Screen Saver tab 

Click the Preview button to see the results of your work 

" Click the Power button to select power options 
You probably don’t need to deal with the power settings unless you have a 
laptop. If so, check the settings to make sure the system is not staying active and 
draining the battery. 

! The Appearance Tab 

" Windows and buttons: keep or select the Windows XP Style 

" Color Scheme: select a color 

" Font Size: select Large Fonts 
Select Effects button 

# Use the following transition effect for menus and tooltips: 

Select Fade Effect 

$ Use the following method to smooth edges of screen fonts: (At home, try the 
various options to see which one makes the words on the screen look the 
clearest. Leaving the box unchecked works best for my flat panel monitor. Clear 
Type is recommended for laptops and other flat panels.) 

# Use large icons 

Click OK to return to the Appearance tab 

The Advanced button.  

Select Icon. You can change the font style and size for icon type. Select a larger size 
and bold if you have trouble reading the type on the monitor. 

Click Apply 

! The Settings tab 

" Screen Resolution 
Slide to 1024x768 

Click Apply. The screen will go black for a moment, then will reappear in the new 
resolution. If prompted, click OK to accept the setting. (If your screen is already set 
at 1024x768, set it to 800x600 and back again so you can see what happens.) 

" Color Quality 
Confirm that the highest setting is selected 
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" Advanced (Click button) 
The tabs available here may differ depending on your monitor and video card. 
However, you should at least run into the following: 

General tab 

Display: Note the DPI setting at Normal size (96 DPI). The other choices are 
120 DPI and Custom. If you are trying to make the screen fonts as large as 
possible to improve desktop readability, you will want to select 120 DPI at home. 
Making this change requires Administrator privileges. You can also change font 
size using the Advanced button under the Appearance tab. 

Monitor tab 

Monitor type. Displays monitor drive and device status. No setting changes. 

Monitor Settings: 

Make sure Hide modes that this monitor cannot display is 
checked before you change any of your Display Settings. (Ask 
me how I know.) 

Screen refresh rate: On a crt monitor, an incorrect refresh rate can cause the 
screen to flicker, driving you mad, causing you to violently murder everyone 
around you. It can also cause the image to darken on parts of the screen. 
Adjust the refresh rate to solve these problems. 

! Back to the Themes tab 

If you like the changes, save the theme. Click Save As. Navigate to the folder you want 
to use, and name the theme. 

Click OK to return to the desktop 

Arrange Icons By 

Right Click on the open Desktop to open the desktop menu 

Sort Order of Desktop Icons 

! Hover over Arrange Icons By 

Another menu will pop up. Select one of the first four choices (Name, Size, Type, 
Modified.) 

Now, Select a different one. You should observe that the desktop icons change order 
based on the choice you make. 

Notice that each time you select something the menu closes. You will have to open it 
again to select the next item. Clicking on an item checks or unchecks it. 

Align to Grid and Show Desktop Icons 

! Now that you are done playing around, right click on the desktop again and make sure 
only the following two items are selected under Arrange Icons By: 

% Align to Grid 

% Show Desktop Icons 
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Delete Icons 

Delete all icons except those you use frequently, and you may want to keep the following. 

% My Computer 

% My Documents 

% Internet Explorer 

% Recycle Bin 

Move Icons 

To move icons, click and drag to the new location. 

Start Menu. 

Hover your mouse pointer over the Start button. The words “Click here to begin” should 
appear. If that doesn’t work, click on Start, then push the Esc key to clear the menu. Try 
hovering again. Remember, hovering means holding the mouse perfectly still over a designated 
area or item. 

Click on Start again to view the contents of the Start Menu. All of the items you see in the 
start menu are actually shortcuts to programs that also appear in the All Programs list, or to 
documents you can find using Windows Explorer. We are going to clear the clutter out of this 
menu. 

Hit Esc to clear the menu 
Right Click Start 

Select Properties. The Taskbar and Start Menu Properties window opens on the Start 
Manu tab 

! Start Menu tab 

Confirm that the Start Menu radio button is selected 

Click Customize 

" The General Tab 
Under Programs: Number of programs on start Menu: select 0. 

Click Clear List 

On Show on Start Menu, make sure both boxes are checked.  

Select your preferred browser and email programs. 

" The Advanced Tab 
Confirm or select the following settings: 
Start Menu Settings 

# Open submenus when I pause on them with my mouse 

# Highlight newly installed programs 
Start Menu Items 

Control Panel 

& Display as a link 
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# Enable dragging and dropping 

$ Favorites menu 

# Help and Support 

My Computer 

& Display as a link 

My Documents 

& Display as a link 

My Music 

& Don’t display this item 

$ My Network Places 

My Pictures 

& Don’t display this item 

Network Connections 

& Don’t display this item 

# Printers and Faxes 

# Run command 

$ Scroll Programs 

# Search 

$ Set Program Access and Defaults 
Recent documents 

$ List my most recently opened documents 
Click Apply 

Click OK 

We have cleaned almost everything out of the Start Menu. Click Start to see how it looks.  

If anything that you do not use still appears, right click on it and select Unpin from Start 
Menu. If that choice is unavailable, select Remove from this list. 

Icons 

You have total control over what icons appear on the desktop and in the start menu. We have 
turned off the features that automatically place icons so we can decide for ourselves what will go 
where. The decisions you make depend on your preferences and work style. 

Click on Start 

Hover over All Programs. The menu of all programs on the system will appear. 

! Locate Outlook Express 

Hover over Outlook Express. 

Right Click to open the menu 
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Hover over Send to 

When the next menu appears, Select Desktop (create shortcut) 

! Locate Microsoft Word on the list. 

Hover over the Word item on the menu so it is highlighted 

Right Click to open the menu 

Hover over Send to. 

When the next menu appears, Select Desktop (create shortcut)  

Hover over Word again. 

This time, Select Pin to Start Menu 

! Repeat this process for whatever other icons you choose 

Taskbar 

The Taskbar is the plain colored bar along the bottom of the display. The taskbar contains the Start 
button, the Taskbar (duh), and the Notification area. 

The Taskbar location. You can size and move the taskbar. Sometimes this happens by 
accident so it is a good idea to know how to do it on purpose so you can fix it. 

! Size 

Position the mouse pointer along the top of the Taskbar so it turns into a double arrow.  

Click and drag upwards to increase the size of the taskbar. 

Now return it to its default size. 

! Position 

Position the mouse pointer in an open area of the Taskbar 

Click and drag to the right side of the screen 

The top 

The left side 

Back to the bottom 

! Lock the Taskbar 

You can lock the Taskbar so can not be accidentally moved 

Right click in an open area on the Taskbar 

Click “Lock the Taskbar” 

The Notification Area. The area on the taskbar to the right of the taskbar buttons. The 
notification area displays the time and can also contain shortcuts that provide quick access to 
programs, such as Volume Control and Power Options. Other shortcuts can appear temporarily, 
providing information about the status of activities. For example, the printer shortcut icon 
appears after a document has been sent to the printer and disappears when printing is complete. 
(I copied this definition from Help and Support.) 

! Hover over the time to see the date 

! Double click on the time to change it 
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! Double click on an icon to open its program window 

! To change Notification Area settings, position the pointer anywhere in the Taskbar and 
right click. The Taskbar Tab will display 

" Notification Area. Confirm the following settings for the check boxes 

# Show the Clock 

$ Hide inactive icons 

Taskbar. Right clicking on the taskbar calls up a menu that controls the way windows display 
on the desktop, allows selection of toolbars to display on the taskbar, allows selection of taskbar 
properties, and some other stuff you might want to look at later.  

! Toolbars. You can select various system toolbars to display in the Taskbar, or create a 
custom toolbar. For now, unselect everything except the Quick Launch toolbar. 

! Taskbar Appearance. Confirm the following settings for the check boxes 

$ Lock the taskbar 

$ Auto-hide the taskbar 

# Keep the taskbar on top of other windows 

# Group similar taskbar buttons 

# Show Quick Launch 

Quick Launch. The quick launch toolbar holds icons for programs you want to start with one 
click from the Taskbar. You can copy Desktop Icons to the Quick Launch Toolbar. 

! Select the My Computer icon on the Desktop 

Click and drag to the Quick Launch area on the Taskbar. 

! Repeat for each Desktop Icon you want to move to the Quick Launch Toolbar. Delete 
the desktop icon, if desired 

Windows Explorer 

Introduction. Windows Explorer is the system’s file manager. You use it to view and organize 
your files. You can get to Windows Explorer in several ways, of course: Right click the Start Button, 
Double click on My Computer or My Documents on the Desktop, Single click on My Computer or 
My Documents in the Start Menu, or Select All Programs | Accessories | Windows Explorer. 

Note: Windows Explorer is the file manager. It is NOT Internet Explorer. These are two completely 
different things. 

Start Windows Explorer: Go to the Start Menu | Click on the My Documents Icon 
View 

You can control the appearance of part of the Windows Explorer window through the View 
menu. 

! Select View (Click on View) 

! Hover over “Toolbars”. The toolbars menu will appear. 

Confirm that Standard Buttons is checked and that Address Bar and Links are not 
checked. 
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Note that you can Lock the Toolbars, and Customize the Toolbars. Do NOT do 
either. 

! Back to the View menu, confirm that Status Bar is checked 

Some users will advise unchecking the Status Bar to maximize the display area of the 
Explorer window. However, valuable info is displayed in the status bar and it does not 
take up that much room. 

Note: Internet Explorer also has a status bar. The above comments apply to it as well. 
For example when you hover over a link, the status bar displays the internet address to 
which the link will send you. 

! Explorer Bar. 

The Explorer bar is the left pane of the Explorer window. Hover over Explorer Bar in 
the View menu to activate the menu of items that can be displayed in the left pane. 
Select Folders if it is not already checked. Putting the Folders list in the Explorer Bar 
gives you the best information about your files and folders as you manage them. All of 
the other items that can be displayed there are available in the Windows Explorer menus. 

! Details 

Back to the View menu, you can control how items in the right pane are displayed. The 
View menu is one way to do that. Another is through the Views icon on the Standard 
toolbar. In any event, select Details. A details view displays the most  information and 
sorting works most effectively in this view. 

Photos. However, if you are searching/viewing photos, you may want to change the 
view to thumbnails to display a thumbnail of the photos without having to open each 
file. To test this, navigate to the More Windows folder. Remember, the photo of my 
house is hiding there. Change the View to Thumbnails. 

Icons. Sometimes an Icon view is the most effective, such as in Control Panel. 

! Arrange Icons By 

Hover over this item in the View menu. Of course you remember these options from 
the “Right Click on the Desktop” menu we studied in our last class. The same choices 
are available here, only instead of arranging the desktop icons, you will be arranging the 
icons (files) in the right pane. 

! Choose Details 

This View menu item lets you choose the columns that will be displayed in the right 
pane. We will not work with this list in class, but you can take some time at home to 
decide if you want additional columns displayed. 

! Customize this Folder 

Ditto 

! Go to 

Gives you some choices of other folders to view 

! Refresh 

Click Refresh to confirm that current changes are reflected in the list.  
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Folder Options Intro. Windows allows you to change the way Windows Explorer displays 
file and folder information by editing the Folder Options. You can get to Folder Options from 
several points. 

! Control Panel 

Click Start 

Select Control Panel 

Select Folder Options 

! Start Button 

Right Click Start button 

Select Explore 

Select Tools 

Select Folder Options 

! My Computer 

Locate the My Computer icon on the Desktop, or in the Start Menu. In the Start Menu, 
click once. On the Desktop, click twice. 

Select Tools 

Select Folder Options 

Note: to display the left pane (folder outline) and the right pane (selected folder 
contents) in any Explorer window, click on the Folders icon on the Explorer Bar. If the 
Folders icon does not appear, select View | Explorer Bar | Folders. 

Reminder: many of the menu options you encounter are toggles: click once to check, 
click again to uncheck. It is a good idea to reopen the menu to confirm that you 
checked/unchecked the correct item. 

After reviewing the different paths to Folder Options, let’s go back there through the Start 
Button (Right Click | Select Explore | Select Tools | Select Folder Options.)  
Folder Options 

! General Tab 

" Tasks 

' Show common tasks in folders 

& Use Windows classic folders 

" Browse folders 

& Open each folder in the same window 

' Open each folder in its own window 

" Click items as follows 

' Single-click to open an item (point to select) 

& Double-click to open an item (single-click to select) 
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! View tab 

" Folder views 
Rather than resetting all folders manually, you can apply a particular view option to 
all folders by clicking the Apply to all folders button 

To return the setting to the Windows XP default, click the Reset All Folders button 

" Advanced settings: 

# Automatically search for network folders and printers 

# Display file size information in folder tips 

$ Display simple folder view in Explorer’s Folders list 

$ Display the contents of system folders 

# Display the full path in the title bar 

# Do not cache thumbnails 

Hidden files and folders 

& Do not show hidden files and folders 

' Show hidden files and folders (select this option if you are an advanced user) 

$ Hide extensions for known file types (make sure this box is NOT 
checked) 

# Hide protected operating system files (Recommended) (uncheck if you are an 
advanced user) 

# Launch folder windows in a separate process 

Managing pairs of Web pages and folders 

& Show and manage the pair as a single file 

' Show both parts and manage them individually 

' Show both parts but manage as a single file 

# Remember each folder’s view settings 

$ Restore previous folder windows at  logon 

# Show Control Panel in My Computer 

# Show encrypted or compressed NTFS files in color 

# Show pop-up description for folder and desktop items 

# Use simple file sharing (Recommended) 
After confirming all of the above, click on apply 

Notice the Restore defaults button. If you get hopelessly muddled, click that button 
to put the View options back the way they were when Windows XP was installed 

! File Types tab 

Do not change any of these settings unless you are confident you know what you 
are doing. These settings determine how particular file types are opened. For example, 
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MS Word puts the .doc extension at the end of the name of each Word file. (Remember, 
we unchecked the “Hide extensions for known file types” box under the View tab so we 
could see file extensions.) 

Find jpg on the list. Usually the default is for a jpg to open in your browser, such as 
Internet Explorer of Netscape. I do digital publishing and design web pages. I do not 
want jpg files to open in Netscape. I want them to open in Adobe Photoshop, my photo 
editing program. Therefore, I would change this setting so that when I double click on a 
jpg file, it opens in Photoshop, not Netscape. It does me no good to open the file in 
Netscape, and is actually annoying because you can’t adjust the view in Netscape to see 
the whole picture at once. At home, change this setting to “Windows Picture 
and Fax Viewer” if you have a problem view photos sent as email 
attachments. 
If you want to change the program a file opens with, click the Change button and 
pick the preferred program from the list.  

Even if a file type is set to open in an undesirable program, you can always use your 
preferred program by launching the program first, selecting File | Open, and browsing 
to the file location. Select the file and click Open. Obviously this only works for files the 
program was designed to open and edit.  

If you haven’t already done so, Click Apply then close to exit Folder Options 
Edit 

You can use Right Click to delete files and folders, and Right Click and Drag to copy and 
move files and folders. You can also use the Edit menu items to accomplish the same tasks. 
Find out more about files and folders in the CLC files and folders class. Check the schedule 
on the bulletin board. 

Control Panel 

To get to the Control Panel, go to Start | Control Panel 
Accessibility 

As you might imagine, these options are designed to improve accessibility/usability for those 
who might have trouble with the Default windows settings. Each person should go through 
these options to determine if any of them would make computing easier for them or a 
member of their family. 

Note that the Accessibility Options under Control Panel are different that the Accessibility 
Programs you can find at Start | All Programs | Accessories | Accessibility 

A couple of settings to note are under the Display tab: Check out Blink Rate and Width, 
both dealing with the cursor. 

Add Hardware 

Generally you will not run into this function. With Windows XP, most everything is plug 
and play and installs automatically 

Add or Remove Programs 

You may need this one though. 



More Windows • Page 12 

When you want to remove a program, you do not just find the folder and delete it. Files 
relating to the program are scattered throughout your computer, and some have names you 
could not identify with the originating program. Instead, use the Remove function here. 

Date and Time 

If your computer clock gets out of tune, you can reset it here. (You can also get to the date 
and time by double clicking on the time display in the Notification area.) 

Display 

This brings up the same Display Properties window we worked with in Lesson 1. 
Folder Options 

Another way to change Folder Options. 
Fonts 

This item takes you to the list of fonts available on your computer. 
Internet Options 

This is the same menu that show up under Tools | Options in Internet Explorer.  
Keyboard 

Let’s look at these options. 

You can adjust how long you can hold a key down before it begins to repeat. You an also 
adjust the blink rate of the cursor.  

Mouse 

There are a few things you can do with the mouse to try to match your style and technique. 

! Buttons 

" Button Configuration 

$ Switch primary and secondary buttons 

This if for left-handed people.  

" Double click speed 
Drag the slider to change the setting 

" Click lock 
Experiment with this to see if it helps you. 

! Pointers 

Pick a custom pointer style at home 

! Pointer Options 

You can slow down the pointer so every little movement does not jerk the mouse away 
from your target. Experiment with this item if you have been having any mouse troubles: 
clicking and double clicking. 

! Wheel 

You can adjust the scrolling as well 
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Scheduled Tasks 

This is the scheduler for functions that occur in the background, such as a virus scan or disk 
cleanup 

System 

A lot of information about your computer is here. We will look at as much as we can within 
our time limits. Come back to this and explore. 

! General 

Go here to find out basic info about your computer: Operating system, processor, 
processor speed, RAM 

! Computer Name 

You won’t need this unless your are setting up a network at home 

! Hardware 

" Add Hardware Wizard 
Here is another way to get at the Add Hardware Wizard. 

" Device Manager 
All the details about your system. 

" Hardware Profiles 
Not relevant to us now 

! Advanced 

ditto 

! System Restore 

While you are merrily taking your computer for granted, it is preparing in the 
background for disaster. It periodically sets Restore Points to return to if the system 
becomes unstable and starts crashing. You can also manually create a restore point using 
the System Restore Wizard. Get there from Help and Support 

! Automatic Updates 

It is a good idea to allow Windows to update your computer. Otherwise you will forget 
to do so at a critical time. 

# Keep my computer up to date . . . 

Select whichever notification option you prefer 

! Remote 

We won’t talk about this, but just make sure the Remote Desktop button is NOT 
checked. The reason should be obvious. 

$ Allow users to connect remotely to this computer 
Close Control Panel 
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